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Constant Acceleration Motion in One Dimension  
(along a straight line).  

 
Introduction and Theory: 
 
In a wide range of motions, the velocity can change from moment to moment. To provide a 
measure of how much the velocity changes in time, the concept of acceleration is introduced. 
 

          Average acceleration = or   aave = . 
 
The average acceleration is a vector that points in the same direction as the change in the 
velocity. The unit of acceleration is m/s2. 
 
By analogy to velocity, when the time interval for measuring the acceleration becomes extremely 
small, the average acceleration becomes equal to the instantaneous acceleration: 
 

                                                      a =  =  
 
For most people, acceleration means speeding up. And when an object is slowing down, we 
sometimes say it is decelerating. But deceleration does not mean that the acceleration is 
necessarily negative. The sign of acceleration indicates the direction of the acceleration but 
doesn’t directly show whether the speed is increasing or decreasing. For a motion along a 
straight line, if velocity, v, and acceleration, a, have the same sign, the object is speeding up. If 
they have the opposite signs, it is slowing down (decelerates).  
 
If we produce a plot of velocity vs. time, the slope of the line tangent to this plot at some instant t 
represents the acceleration at time t. In case of uniformly accelerated motion (acceleration is 
constant) the velocity vs. time graph is a straight line. 
 
Derived from the definitions of velocity and acceleration, there are four basic kinematic 
equations governing the motion with constant acceleration. To simplify our notation, we assume 
that the initial time t0 = 0. The position at any given instant of time, t, of an object moving with 
constant acceleration a, having initial position  and initial velocity v0, can be found as: 
 
                                           x = x0 + v0t +  at2                                                                      (1) 
The velocity (instantaneous) of an object after time t can be determined as: 
 
                                            v = v0 + at                                                                          (2) 
 
or, if we know the position x at time t, the velocity can be calculated from the following: 
 
                                          v2 = v0

2 + 2a(x – x0).                                                                    (3) 
Note that x represents position, not distance, and x – x0 is the displacement. 
 
Because in case of constant acceleration the velocity increases at a uniform rate, the average 
velocity, vave, will be always midway between the initial and final velocities: vave = (v0 + v). 
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Fig. 1 Graphs of position (a), velocity (b) and acceleration (c) vs. time for a body moving with 
constant acceleration. 

Objects that move vertically near the surface of the Earth, either falling or having been 
projected vertically up or down, move with the constant downward acceleration due to gravity 
with magnitude of about g = 9.80 m/s2, if the air resistance can be ignored.

Consider an object, initially at rest, v0 = 0, that at time t0 =0 is released from a height y above
the ground. It falls down and after time t it reaches the ground. After inputting x0 =y and v0 =0
in equation (1) and rearranging it, we can find the gravitational acceleration (an unknown a) as:

a = g = -   .         (5) 

Therefore, by measuring the distance an object travels for a specific amount of time under the 
influence of Earth’s gravitational acceleration, we can determine the value of g.

Objectives: 

! To gain understanding of relationships between position vs. time and velocity vs. time 
       in uniformly accelerated motion. 
! To determine the experimental value of the gravitational acceleration g on Earth using

kinematic equations and video analysis. 

Equipment: 

VirtualPhysicsLabs environment - frictionless cart and track with ultrasonic motion sensor; pre-
recorded video of freefalling objects;  or Logger Pro software. 

Procedure: 

Go to the simulation website: 
http://virtuallabs.ket.org/physisc/ 
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Log in and press the Labs tab. Click on the icon labeled Dynamics Track to access the 
Kinematics in One Dimension experiment. Run the Kinematics in One Dimension lab by 
clicking on the “Dynamics Track Lab” link. Familiarize yourself with the set-up. With the mouse 
right-click in the graph area change the Using Errorless Position Data option to “Using the 
Realistic Position Data.” 
 
PART 1. Uniformly accelerated motion along the dynamic track. 
 
Run 1. Car speeds up while moving away from motion sensor. 
 
A. Turn on brakes to hold the cart in place. Set the “Recoil” feature to 0. 
Tilt the track to an angle of - 2° (negative 2 degrees). Keep the time “Tmax” setting at 10 s.  
Drag the cart close to the left end of track. Turn on the motion sensor and release the brakes. 
Stop the recording when the cart reaches the other end of the track. Turn on the brakes. 
 

                                  
 
                                    Fig. 2. Screenshot of sample recording for run 1A. 
 
 
How can you tell that the cart was not moving with constant velocity? In what way is this plot 
different from the position time graph for constant velocity motion? Turn on the position and 
time grids (right click on the graph window) and try to estimate distances traveled by the moving 
cart in two consecutive time intervals (for example between 3.0 – 4.0 s and 4.0 – 5.0 s). Does 
your estimate prove the change in velocity? Be sure to answer this question in discussion 
section.  
Copy the data to the clipboard and paste it to Logger Pro. Label the columns adequately (Time 
and Position) and enter correct units for each quantity. Double click on the graph and uncheck 
the option Connect Points. On the graph highlight the curved part corresponding to the cart 
moving along the track and fit the selected part of data to a quadratic equation of the same kind 
as equation (1) in the Introduction. 

Hint: Click the first from right icon on the tool bar or pull down the Analyze menu and 
choose the Curve Fit feature. In the Curve Fit window select Quadratic, make sure that the Fit 
Type is automatic and press Try Fit. If the fitting line matches your original data points (in the 
selected region) click OK. 
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Interpret the numerical values of the fit parameters – name the physics quantities they present. 
Calculate the acceleration using one of the parameters from curve fit. 

Calculate velocity as derivative of position data with respect to time. To accomplish this first 
select 3 points for derivative calculations in the Settings for startup (in the pull down File menu). 
Next, create new calculated column in the data table for velocity (Data → New Calculated
Column " Functions " calculus " derivative (variable“Position”)). Insert a new graph 
showing velocity vs. time. Based on this graph, how can you tell that the acceleration was 
constant? Apply linear fit to the portion of constant acceleration motion. What does the slope of 
this line mean? Does it agree with the value of acceleration from the position vs. time fit? 

B. Tilt the track to a smaller negative angle of your choice and make a new run. Copy/paste the 
data to Logger Pro as a new data set. Add this new data to the existing position vs. time display 
and velocity vs. time graph window. 

Hint: Add the new data points to the existing displays by clicking the vertical axis label on the 
graphs, opening the Data Set 2 option and check-marking the columns of interest. 

Compare the curvature of the parabolas of both runs 1A and 1B. How did the curvature 
change as the acceleration of the cart changed? Apply the quadratic and linear fits as you did 
in part A. What coefficient of velocity vs. time equation tells us the magnitude of acceleration? 
What attribute of graphical representation of motion characterizes the direction of acceleration? 

Save the Logger Pro file for future reference. 
Organize your Logger Pro graph windows so they fit on one page, capture the screen and paste 
it into a Word file – you will have to attach it to your lab report. 

Run 2. Car speeds up while moving towards motion sensor. 

Tilt the track to an angle of + 2°. Make sure the brakes are on. Drag the cart close to the right end 
of track. Turn on the motion sensor and release the brakes. Stop the recording when the cart 
reaches the other end of track. Turn on the brakes.  
How different is the shape of the position vs. time graph in comparison to run 1A? 
Copy/paste the data to Logger Pro and follow with analysis same as in run 1(quadratic fit for 
position vs. time plot, linear fit for velocity vs. time plot – remember to select 3 points for 
derivative calculations in the Settings for Startup in the pull down File menu before creating a 
new calculated column in the data table for velocity). Why is the acceleration negative even 
though the cart was speeding up? 

Save the Logger Pro  file for future reference. 
Capture the screen and paste it into a Word file – you will have to attach it to your lab report. 

Run 3. Car slows down while moving away from motion sensor. 

On the track still tilted to + 2° as above, move the cart all the way to the left. Release the brakes,
click on the motion sensor and give the cart push uphill. If you have problems releasing the cart 
with a push, set the “V0?” to # 0 and press “Go "” button situated next to “V0?” Stop recording 
before the cart changes direction. Turn on the brakes. 
Copy/paste the data to Logger Pro and follow with analysis in the same way as in run 1(quadratic 
fit for position vs.time plot, linear fit for velocity vs. time plot - remember to select 3 points for 
derivative calculations in the Settings for Startup in the pull down File menu before creating a 
new calculated column in the data table for velocity). Compare the shape of the position vs time 



Page 5 of 7 

graph to run 1A and 2. Why is the acceleration negative while the velocities are positive in run 
2? 

Run 4. Cart slows down while moving towards the motion sensor. 

Tilt the track to a negative angle = – 2.5°. Bring the cart to the right end of track. Release the 
brakes, initiate the recording and push the cart uphill to the left. If you have problems releasing 
the cart with a push, set the “V0?” to # 4 and press “Go "” button situated next to “V0?” Stop 
recording before the cart changes direction. Turn on the brakes. 
Copy/paste the data to Logger Pro  adding it as a new data set to run 3 data table. Follow with 
analysis the same as above (quadratic fit for position vs. time plot, linear fit for velocity vs. 
time plot). This time the acceleration is positive even though the cart is slowing down with 
time. Why? Why are the velocities negative? Compare the shape of the position vs. time graph 
to the plots from the previous runs. 

Save the Logger Pro  file for future reference. 
Capture the screen and paste it into a Word file – you will have to attach it to your lab report. 
If you had known the acceleration would you be able to deduce whether the object was speeding 
up or slowing down? Explain the reasoning behind your statement/answers.  

PART 2. Free Fall. 

A. Open Logger Pro and insert the pre-recorded movie FREE FALL (Insert → Movie). The
Logger Pro program is very similar to Graphical Analysis but also allows for video analysis of 
movie clips frame by frame. For better results in the settings for your file (in the pull down File 
menu) change the Number of Points for Derivative Calculations to 3. 
When the movie window pups up follow these steps: 

1. Click on the Enable/Disable Video Analysis tool  on the bottom-right edge of the 
movie to open the video analysis tools.

2. Use the Set Origin tool (  ) to select a suitable origin, by clicking there. Suggested 
location is at the ground level somewhat to the left of the path of the falling ball.

3. Then use the Set Scale tool (  ) to set a distance scale on the movie. Click and drag
across some object of standard length in your video. Enter its length in the dialog box.
For instance it could be the height of the first floor protruding wall (Hwall = 2.16 m) or the
hard to see 2-m meter stick resting against the wall (see Fig. 3). For this and the next step
open the movie window as much as it is needed for good markings.
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Fig.3 . Free fall calibration standards."

4. Advance the movie to the time at which you desire to start extracting data ( maybe a few

frames after the ball was released) and then use the Add Point tool (  ) to add data
points one frame at a time. Click on the object you wish to follow and the movie will
advance a frame. Click again on the object and the movie will again advance. Etc. Mark
this way the trajectory of the center of the falling ball.

As you were busy extracting the position-time data from the video, Logger Pro was inputting that 
information (x and y coordinates of the ball position and velocity in each frame) into a table, and
plotting it on a graph. Since the ball was only moving vertically in y direction we expect the
horizontal position should not change. Is this true for your data? Select Insert a new graph and 
display the velocity vs. time data, also calculated by Logger Pro, for y direction. Use adequate
fits for Y position vs. time and YVelocity vs. time data to find the acceleration the ball was 
acting upon. 

Hint: For the position vs. time fit you will need to use a quadratic expression similar to equation 
(1). After highlighting with computer mouse the Y position data points of interest in the graph 

window, click on the rightmost button in the tool bar and check the quadratic function. 
Double click the Auto Fit window and select Show Uncertainty in the Curve Fit Options 
window. 

The uncertainty in the slope of velocity vs. time graph equals the uncertainty of the experimental 
gravitational acceleration. State the final value of g you have found from the movie, along with
its uncertainty. Remember that the error (uncertainty) should be expressed with maximum 2 
significant figures (preferably only one) and the least significant figure in the error should have 
the same decimal position as the least significant figure in the main result. Compare it with the 
known gravitational acceleration of 9.80 m/s2 → calculate percent discrepancy:

%disrepancy =
gexp− gtheor

JWKHRU
*100%

2.16 m 

2.00 m 
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Save the Logger Pro file for future reference. 
Organize your Logger Pro graph windows so they fit on one page, capture the screen and paste it 
into a Word file – you will have to attach it to your lab report. 

B. In the movie clip the ball was released 7.42 m above the ground. In the same setting the 
students dropped the ball 3 times and measured the times of fall with a stop watch. They 
recorded the following values: 1.33 s, 1.21 s and 1.24 s. From the average time of fall, calculate 
the experimental gravitational acceleration. Knowing that the uncertainty in the height 
measurement is ΔH = 0.02 m and the average human response time is Δt = 0.2 s, estimate the
uncertainty in your experimental g. Refer to the rules for error propagation presented in the
introductory materials Basic Concepts of Error Analysis. Report the calculated value of 
experimental g along with its uncertainty considering the rules for significant figures.
Using the given data and ignoring the air resistance, calculate the final velocity of the ball at the 
bottom of the fall – state this value along with its uncertainty. 


